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Creating Distribution Lists in Outlook: By Carole Colburn 
A valuable feature of Outlook 2000 is the ability to create distribution lists. This allows you to send the 
same message to many people at the same time, without having to find each name in the global address 
field or in your contacts, or to type each name in the To: field individually. Essentially, you create a named 
list in your personal address book and then add the names of the people you want included in that list. 
Then, when you send the next e-mail, you send it to the distribution list so that all of the members of that 
list will receive the message. To create a distribution list follow the steps below. 
 

1. Click the New Mail Message Button as if you were going to send a new message. It 
looks like this.  

 

 
 

   
  



   

   
  

 
2. This will open a new Untitled Message window. It looks something like this. 

 

 
 
 

3. Click the To: Button to open the Select Names Dialog Box.  
 

 
 



   

   
  

 
 

4. Click the New… Button to open the New Entry Dialog Box. It looks like this. 
 

 
 
 

5. Make sure that New Distribution List is selected and that it says Contacts in the “Put 
this entry…in the field.” Then, click the OK Button. 

 
 

  
 



   

   
  

6. When you click the OK Button, this will open the Untitled-Distribution List window.  
 

 

 
 
 

7. In this window, you will type a name for your distribution list (example: All Third Grade 
Teachers) in the Name field.  

 
 

 
 
 



   

   
  

8. Next, click the Select Members… Button. This opens the Select Members Dialog box.  
 

 
 
 

9. Now, type the first few letters of the person’s last name (the person you wish to add to 
this list) and then click to select that person’s name. Then, click the  
Add-> Button to add the name to the “Add to distribution list” field on the right.     Then, 
click the OK Button. 

 
 

 
 



   

   
  

 
10. This places the person in that distribution list. 

 

 
 
 

 
11. Finally, click the Save and Close button.  You can add new members to the list at any 

time, by clicking the Add New… Button or remove any member by selecting the 
member you wish to remove and then clicking the Remove button.  

 
 

 



   

   
  

 
 

Accessing the Distribution List 
 
1. Open a new mail message window and then click the To: Button. This opens 

the Select Names dialog Box.  
 

         
 

2. Click the drop down arrow next to where it says, “Global Address List” and then 
scroll to the bottom where it says “Contacts.” 

 

 



   

   
  

 
3. When you click “Contacts” this will show you all of the people you have in your 

Contacts component of Outlook. If you have not put any names in this portion of the 
program, you will only see the bolded distribution list you just created.  

 

 
 
 

4. If you select “All Third Grade Teachers” and click the Add-> Button, this will 
place “All Third Grade teachers” in the Message Recipients field on the right. Click 
the OK button and this will place “All Third Grade Teachers” in the “To:” field of 
your new message. All of the people who are included in this Distribution list will 
receive this message. 
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FYI: ABACUS training will be taking place at each of the schools during the months of January and February. 
ABACUS is the curriculum management component to SASI xp and is a great tool for teachers to use to 
correlate lessons with the state standards and benchmarks. Look at the Training Calendar link at 
http://www.howellschools.com/~training/index.html to see the days and times training will be offered at your 
building.  

FYI: If you have something you want to advertise (house for sale, free kittens, looking for a ride, etc.) please 
use the HPS BIG BOARD, located on the Public Folders List in Outlook. Thanks! ☺ 
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Lesson Plan of the Month 

The following lesson plan comes from: Linking and Learning-Technology Integrated Planning Steps  

Submitted By: 
Name: Cathy McCarthy 
School District: Parchment School District 
School: North Elementary 

A Study of Vertebrates 1 
Best Practices of Technology Integration 
Title: A Study of Vertebrates 1 

http://www.howellschools.com/~training/index.html


   

   
  

Subjects(s): Science 
Intended Grade Level(s): 4 
 
 
Description: 
The purpose of this project is to introduce students to the world of 
vertebrates. By the end of their study, students should know vertebrates 
are animals that have backbones as part of their skeletons and skull 
bones for support and protection. Students will know where various 
vertebrates live, what they eat, how they reproduce, and why they are 
an important part of the environment. They will know there are seven 
main vertebrate groups. Students will know the characteristics of each 
vertebrate group. Fish live in water and are the simplest vertebrate 
group. The three groups of fish are the jawless fish, cartilage fish, and 
bony fish. Fish are cold blooded, have scales, gills, and a heart with two 
chambers. Most fish have fins. Amphibians live part of their life in 
water and part on land. They are cold-blooded, have moist skin, no 
scales, and most young breath with gills and live in the water. They 
change into adults gradually (metamorphosis) and breathe with lungs. 
They have three heart chambers, and lay their many eggs in water. 
Reptiles live mainly on land and are more complex than fish or 
amphibians. Reptiles are cold-blooded, have dry, scaly skin and most 
(excluding snakes) have two pairs of legs with five toes on each leg. 
They breathe with well-developed lungs, have hearts with three 
chambers, and reproduce by laying eggs with tough, protective shells. 
Reptile babies resemble reptile adults. Reptiles include turtles, lizards, 
alligators, and snakes. Birds are vertebrates with feathers and wings, 
and they are warm-blooded. Birds’ hearts have four chambers. Most 
birds have wings, build nests in which to lay hard-shelled eggs, and 
they care for their young until they can find food and survive on their 
own. Mammals are the most complex group of animals. They have 
body coverings of hair or fur, are warm-blooded, have hearts with four 
chambers, and have more complex brains than other animals, more 
complex body systems. Most mammals give birth to live young, and 
females have special organs that produce milk to feed their young. 
 
A Study of Vertebrates 2 
Once students have learned about vertebrates and recorded their 
learning’s in a science journal, students will be divided up into seven 
groups and each group will produce a HyperStudio presentation about 
their vertebrate group. Once the HyperStudio presentation is completed, 
the final project will be presented to the rest of the class using the LCD 
panel. It will also be saved on the computer to be used for science night 
and future students who need reteaching in a manner other than 
traditional teaching methods. 
 
Curriculum Benchmarks: 
MI.SCI.III.2.EL.1 



   

   
  

Compare and classify familiar organisms on the basis of observable 
physical characteristics 
MI.SCI.III.2.EL.2 
Describe vertebrates in terms of observable body parts and 
characteristics 
MI.SCI.III.2.EL.3 
Describe life cycles of familiar organisms 
MI.SCI.III.2.EL.4 
Compare and contrast food and environmental needs of selected 
organisms 
MI.SCI.III.3.EL.1 
Give evidence that characteristics are passed from parents to young 
MI.SCI.III.4.EL.2 
Explain how physical characteristics of organisms help them to survive 
in their environments 
Technology Benchmarks: 
MI.WP.El.4 
File Menu, open, close, save as, edit menu undo, copy, cut, paste, select 
all, font type and size 
MI.DP.EL.3 
Picture menu, 
MI.DP.EL.4 
Access template, know optional border and color 
MI.OLT.EL. 
Access through signing on and off, learn acceptable communication 
MI.MM.EL.3 
Create test, image, and record sound 
MI.MM.EL.4 
Organize and arrange information for a multimedia presentation, create 
and import images from a variety of sources, create and use sound from 
a variety of sources, knowledge of currently available software 
 
A Study of Vertebrates 3 
 
Materials/Hardware/Software: 
To complete this project, the students should have access to the 
following: 
Computer, either PC or MAC 
HyperStudio software program for Windows or MAC, Roger Wagner, 
Pub. 
Various trade and text books, CD’s dealing with science topics, a 
science journal, pencil 
Teacher with knowledge of above materials 
LCD Panel and overhead projector 
Access to the Internet for research 
Group of students to work together 
Patience 
Some Internet resources: 



   

   
  

Vertebrate Pests home Page: http://web.css.orst.edu/topics/pests 
Vertebrate/index.html: 
http://www.med.stanford.edu/creatures/infoframes/vertebrates 
http://www.ucmp.berkeley.edu/vertebrates/vertintro.html 
 
Teacher Preparation: 
Prior to the HyperStudio project beginning, students will have extensive 
instruction in the area of vertebrates. Using their science journals, 
students will take accurate notes and be prepared to discuss these notes 
with their class as the instruction progresses. These notes will also be 
used in review work prior to the start of each day’s presentation. A 
teacher aide will work with students to find articles or information 
about different types of vertebrates. 
 
Prerequisite Student Skills: 
Knowledge of HyperStudio®. 
 
Activities/Procedures: 
Students will be divided up into seven groups to design a 
HyperStudio® presentation for each vertebrate group. The groups may 
be divided by having each student write down two groups they would 
like to be involved with, or the teacher may select to do co-operative 
group selection, making sure a leader, a follower, a scripter, and some 
supportive, encouraging student is in each group. 
Next, the students, who are already familiar with HyperStudio® from 
third grade work done on that software, will sit down and discuss how 
they want their final part of the project to look. Each group will take a 
turn on the computer working on their project. The first group will do 
their presentation on the jawless fish, then the cartilage fish group will 
put their work onto a stack, followed by bony fish, amphibians, reptiles, 
the bird group and finally the mammal group. Once finished, the entire 
presentation will be shown to the group using the LCD display board. 
This presentation will be carefully saved and will be pulled out for open 
house, teacher conferences, or science night. It will also be made 
available to other classrooms, should they wish to observe our learning. 
 
A Study of Vertebrates 4 
 
Assessment/Evaluation: 
A final evaluation will be administered to students using the district’s 
outcome test for vertebrates. At least 90% of the students should pass 
the test, but for those that don’t, this presentation can be viewed by 
those students for reteaching. Once they feel they are ready for 
retesting, an aide will give them the retest. 
 
Follow-up Activities: 
This presentation on vertebrates can be a station at science night, can be 
shown at parent teacher conferences, or at open house activities. It may 

http://web.css.orst.edu/topics/pests
http://www.med.stanford.edu/creatures/infoframes/vertebrates


   

   
  

also be shown to the Parent Teacher Organization at one of their 
meetings, as they love this type of activity and for even more publicity 
of what fourth grade students can accomplish, this presentation could 
be shown to the School Board when they meet in our building. (Our 
school board meets at the Middle School for most of their meetings, but 
they do rotate through all five buildings in our district and when they 
are in your building, what is happening in our school is really stressed. 
They would love seeing how we used technology since they have 
recently made a big commitment to technology.) 
  

  

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  
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 Carole’s Training Corner  
Happy New Year! Welcome to 2002! It is almost unbelievable to say 2002 when it seems like just 
yesterday the big talk was about Y2K!  

Well, January and February are ABACUS months for me. That is, I will be scheduling ABACUS training at 
all of the schools and if you have not yet received a notice that I will be at your school, look for one soon 
via e-mail to let you know when I will be there. You can also check out the days and times at: 
http://www.howellschools.com/~training/TrainingCalendarPage.htm For those of you who are not aware 
of ABACUS, it is the curriculum management component to SASI xp which allows you to access the HPS 
District curriculum that is correlated to state standards and benchmarks. Many teachers worked last 
summer to create curriculum maps. These trainings will give you a chance to see and learn how to use 
the fruits of all of their hard work.  

Beyond February, I will be looking at offering T4: Tomorrow’s Technology, Today’s Teachers again, 
possibly as a Friday night/Saturday, Friday night/Saturday class. This technology integration workshop 

mailto:colburnc@hps.k12.mi.us
http://www.howellschools.com/~training/TrainingCalendarPage.htm


   
was a great success last summer and teaches both basic skills and integration techniques. Look for 
further information in a later edition of the HPS TECH TIMES.  

Again, Happy New Year and all best wishes to each of you for a healthy and happy year! ~Carole  
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

UNDERSTANDING THE HOT ZONE  
When Word hyphenates your document, it checks to see how much of a word could 
be moved to the previous line if it was hyphenated. To do this, it uses what 
is referred to as a hot zone or a hyphenation zone. This is an area that is 
eligible for hyphenation at the right side of each line. You set the hot zone 
when you choose Hyphenate from the Tools menu. If you choose a hot zone of 
1/2 inch, then Word will not hyphenate a word if the space on the previous 
line is less than 1/2 inch. Setting a small hot zone results in more 
hyphenating, whereas a larger hot zone results in faster operation of the 
hyphenation tool.  

********************************************************************** 
VIEWING YOUR DOCUMENT FULL-SCREEN 
There may be times when you want to see as much of your document as possible. 
You can quickly maximize your document to replace virtually everything else 
on your screen by choosing Full Screen from the View menu. When you are done 
working with Word in this manner, click on the on-screen button to restore 
the regular Word view, or simply press the Esc key. 
 
In addition, if you move the mouse cursor off the top of the screen when 
viewing your document in full-screen mode in Word 97 or Word 2000, then the 
menu bar appears and you can use it to manipulate your document. 
 
********************************************************************** 
QUICKLY DISPLAYING THE PAGE SETUP DIALOG BOX 
 
When you are working in Page Layout view, Word provides a quick and easy way 
to access the Page Setup dialog box. To access the Page Setup dialog box, 
simply position the mouse cursor anywhere on the gray portions of the rulers 
(either horizontal or vertical) and then double-click. You can then make your 
changes and have them immediately reflected in what you see on the screen. 
 
********************************************************************** 

EDITING A TEMPLATE  
Templates are a guide for Word as to how your document and working 
environment should appear. Templates contain information on the AutoText 
entries, macros, styles, and default text, custom toolbar and command 
settings. Editing a template is much like editing a regular document; the 
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only difference is that the file is saved with a DOT filename extension 
(instead of DOC).  

To load an existing template so you can edit it, do the following:  

1. Choose Open from the File menu, or click on the Open tool on the 
toolbar. You will see the Open dialog box.  

2. In the List Files of Type box, select Document Templates (*.dot). The 
filename display will be changed to show only template files.  

3. Change to the directory where the template is stored.  
4. Select the template file you want to edit.  
5. Click on OK. 

When you are done making changes to your template, you can save it the same 
as any other document. (Just click on the Save tool or choose Save from the 
File menu.)  
 
********************************************************************** 
SELECTING A TEXT BLOCK 
When working with some forms of data in Word (particularly tabular columns of 
information), it is often helpful to select non-sequential text in a block. 
For instance, you might want to select the tenth through thirtieth characters 
on each of five lines, ignoring everything else. Word makes this easy to do, 
using either the keyboard or the mouse. If you want to select a block of text 
using the keyboard, follow these steps: 
 
   1. Position the insertion point at the position that defines the 
      upper-left corner of the block. 
   2. Press Ctrl+Shift+F8. The letters COL appear on the status bar. 
   3. Use the cursor control keys to extend the block to include all 
      the text desired. 
 
If you would rather use the mouse to block the text, you can do so by simply 
holding down the Alt key as you make your selection. 
 
Once your text block is selected, you can take any action desired. 
For instance, if you press the Del key, then the block of text is deleted. 
 
********************************************************************** 

Back to Top of Page 

 

Great Lesson Plan Links For You to Try…     

http://thegateway.org/ 

http://www.umsl.edu/~sahambr/teacher_toolbox.html 

   
  

http://www.hps.k12.mi.us/Curriculum1.html
http://glen.cc/mtip/


   
http://www.nearctica.com/educate/lesson/elink.htm 

http://www.openhere.com/edu/k-through-12/educators/teaching-resources/lesson-plans/ 

http://www.bangorvikings.org/dano/ins/inet_ins.html 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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http://www.remc7.k12.mi.us/oaisd/miclimb/
http://www.cyberlearning.org/
http://www.brainbuzz.com/topsites/Default.asp?CatID=1
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